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Simulation of sound propagation indoors employing the RAMSETE/AURORA software package
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Evolution of Ray-Tracing program
In this chapter we look at the calculation methods that are suitable to be implemented with a computational algorithm, this because, as we will see, the modeling of a sound source still requires the manipulation of a huge quantity of numerical data, which cannot be done without the aid of computers.
First of all is the well-known formula of the acoustic semi-reverberant field: 
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This is a simple but powerful formula, where the Sabine's formula is considered valid. The error is within a few dB therefore avoids the need to use sophisticated algorithms which may have higher error if the input data are wrong. There is a small number of cases where the formula is not valid due to not considered diffracted waves caused by the presence of an obstacle.
The first advanced model for computer that considered the geometry, materials and shape of the environment was the Image-source model. This method works very well within parallelepiped environment where the construction of the mirror image is easier. When we have an intricate geometric shape, the construction of the image source of high order (the first one is still simple) becomes more difficult.
So we generate millions of image source but only a few thousand of them pass the test of visibility and thus becomes a very slow method. 
Ray Tracing was the method which replaced the Image-source model. This model represents the propagation of sound, from a point source, such as a set of rays. It can be considered a Montecarlo method also because statistically by launching a large number of rays the result converges to the exacted value. These rays are followed in all their rebounds until one of them reaches the receiver which is usually a sphere of one meter in diameter. All the times that a ray passes through this volume, it leaves a dose of acoustic energy that is proportional to the length L of the segment crossing this volume. Ray Tracing is a very accurate model even in environments which not have a regular shape,  but it may take to launch even millions of rays to obtain an acceptable result. For this reason the computation time of Ray Tracing are extremely high and was therefore replaced with other models.
Modern calculation methods are called Beam Tracing i.e. divergent beam. We launch bundles from the source with a specific opening angle rather than filiform beams, that don't diverge. 
The first used model was Cone Tracing that is the tracing of cones and only after it came to Pyramid Tracing, that is what we will use later. The difference between these two methods is that with cones we are unable to cover the entire surface of the sphere or we covers two times the same region. If you keep the cones separated there will be areas that will never be hit by the receiver. If we intersect cones there will be areas that will give the same contribution twice. With Pyramid Tracing the surface of the sphere is perfectly divided into pyramids, without leaving holes or create pyramids overlapping. 


So every receiver is hit by only one pyramids, so it is much more accurate and also much more fast because you don't need to cover the error by launching millions of rays. Is not anymore statistical model is almost deterministic because every receiver only need one pyramid.
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Figure 1: Comparison between Cone Tracing (left) and Pyramid Tracing (right).
It reduces significantly the computation time passing from 3 day employed by Ray Tracing or Cone Tracing, to a few minutes taken by Ramsete (Pyramid Tracing) for a simple computation.
As the whole pyramid always follow the history of its central ray, it may happen that even if the beam is wider than the reflecting surface, I will reflect this beam. So even if the edges of the beam does not hit completely the surface, the whole beam is reflected. This causes an error because the receiver n. 1 is outside the illuminated area and should not get any reflection by the wall.
[image: image5.png]Receiveru. 1

)

o

Sound Sourc





Figure 2: Errors caused by diverging beam tracers: missed or erroneous detections (left) and "sharpening" of the beam in case of visibility check (right).
Also the opposite error can occurs, actually much more often, in this case the receiver number 2 is not getting energy when it should get. So it is not so true that pyramid tracing is a completing deterministic and accurate model but there are two intrinsic errors: missed detection or getting a detection which should not be got. This is the reason for which you still need to launch for example one thousand of pyramids, because some statistical averaging smooth out this error. The right image show what happens with an Image-Source model, when you launch a pyramid, you are actually losing some part of the reflections like if the pyramid becomes narrower. As long as it reflects, it looses some part of reflections, so the pyramids becomes narrower and narrower and illuminates a number of number of receivers which is smaller than what should be.
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Figure 3: Theoretical and effective echo density in a Sabinian case.
This translates into a number of reflections arriving to each receiver which is not increasing as the theory predicts. Following the Sabine Theory in a perfectly reverberant room the number of energy arrival to each receiver should increase with the square of time. In reality in a pyramid tracing computing scheme, initially the number of received pyramids follows the theoretical model, but then it flattens to an almost average long time value, so you never get all the reflections you should get.
This produce an underestimation of the reverberant tail. The red curve in the next image is a simulation with a large number of pyramid, which suffer of a very small error and is substantially correct, that is what we should get. If we launch only 256 pyramids with no correction, we get the blue curve, so we are underestimating both the reverberant tail and the reverberation time. We need to apply a correction to get the black curve that has the correct slope even being computing by only 256 pyramids.
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Figure 4: Impulse response with and without tail correction compared with the "true" one.

This simple trick allows us to obtain correct results with fast calculations. Without making this correction, also Pyramid Tracing would require millions of pyramids for being accurate.
The correction is computed in Ramsete employing the theoretical estimate of the temporal density of reflections, which is a Sabinian field, so the number of wavefronts impinging in the time unit on a point receiver increases with the square of the time elapsed from the sound emission:
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When the base of the beam becomes larger than the room, all the receivers are hit at each reflection of the wave front, so the number of detection par second tends to a constant value:
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 is the time at which the theoretical parabola of eq.(1) intersects the constant value of eq.(2):
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The transition between the first part (parabolic) to the constant value of eq.(2) can be described with the following equation (Maercke-Martin):
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The ratio of eq.(1) and eq.(4) is used as a multiplicative correction factor, and is applied to the computed impulse response.
So Ramsete computes the ratio between the real and theoretical temporal density and employs this with a multiplicative correction factor which brings up the tail of the curve. This is done automatically by Ramsete, but you must be aware of this fact, because if you use a too small number of pyramid you can still get some errors in the evaluation of the reverberant tail.
In the past the computational power available was very little so it was mandatory to use only a small number of pyramids. Nowadays, thanks to the increasing speed of computers, we do not longer have to worry about this kind of problems.

RAMSETE

Ramsete is an advanced software package for the acoustic simulation. Thanks to its powerful features it can be used to study auditoriums, theaters, or industrial acoustic treatments and external noise sources. 

It is a modular system that can be easily updated and used even by non-professionals.

The main modules used during processing phase are:
1) Ramsete CAD: Is a simple 3D CAD that features axonometric and orthogonal views of the room and can import/export DXF files generated for example by AutoCAD.
2) Source Manager: Manages the sound sources and their directivity, and allows to view three-dimensional balloons at various frequencies. This information can be edited or imported from polar diagrams, allowing you to create a database of custom sources (Ramsete already includes many pre-defined sources, mostly loudspeakers of various brands).

3) Material Manager: This module manages the materials acoustic properties such as absorption coefficients or sound reduction index. As well as the Source Manger, it allows to edit or add new materials to the database.
4) Ramsete Tracer: Ramsete Tracer is the heart of the package, receives a Ramsete CAD model as input and computes the impulse responses at the receiver points for further processing. This program is based on a pyramid tracing algorithm and geometrical acoustics.
5) Ramsete Graph: Ramsete Graph can post-process these impulse responses and give a graphic or tabular view of the data. For each one of the ten frequency bands and for each receiver it can display the impulse response, linear and A weighted, the SPL levels and the reverberation times: T10, T15, T20, T30 etc..
6) Ramsete View: Ramsete View can display perspective views of the geometric models and it can render and map for example the Sound Pressure Level (SPL), Direct Wave level or the Reverberated field level. 
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Figure 5: RAMSETE block diagram.

In opposite of the majority of commercial software in which there is only one executable file, in this case you have different modules developed by different people at different times. This factor has made it possible to separate the tasks, so who was in charge of Ramsete CAD did not have to know how to program the pyramid tracing algorithm.
So the typical steps to produce a quick simple simulation are: 
Draw CAD geometry with Ramsete Cad, process this data with Ramsete Tracer and analyze the results with Ramsete View (which, in the latest version of Ramsete, now includes Ramsete Graph). Let's see now a typical example.
Using RAMSETE

The starting point is Ramsete CAD  that allows you to create the geometry you want. It provides several tools to create individual walls, floors and ceilings or for example to create in a single shot all of them with the "Box" tool.
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Figure 6: Employing Ramsete CAD to create a simple geometry. 

For each inserted object, it will be required both its location within the geometry and the material of which it is made. 
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Figure 7: material input.
This window shows the value of the absorption coefficient α (at different frequencies), the sound reduction index R (R = 0 means that nothing passes, in practice it means R=∞), and the scattering coefficient s of the material. 


You can also add doors or windows, remembering that they belong to a wall, so you have to first select the wall on which to place the object and then use the tools "Door" or "Window". Another tool that you can use is the tool "Tube", particularly useful in industry, in this case is required both the radius and the material.
At this point by clicking the tool "Speakers" you must enter its location and the target point (its direction), so you must enter the type of source you are adding (eg Bose).

[image: image15.png]Sou

Source file

parameter:

| \Ramsete27\Sources\loudspkribose\101-AP.SPK

Source position:
Target position:

Roll angle:

22 9.8 17
8.2 7.4 0
o
Cancel





Figure 8: Source parameters.
As we will see later, it is also possible make separate simulations for each source present in the geometry.

Now we need to add receivers, using the tool "Receivers" (drawn as headphones).
By holding down the "upper" key, and selecting the affected area, you can automatically put in a single shot a grid of receivers.
The receivers covers the whole area at a fixed height (which is usually the hear height) and with a customized Step (distance between two receivers).
In this way you create a set of uniformly distributed receivers that allows to have accurate results when you create isolevel maps.
If you use few receivers, the software is not able to create accurate maps. It is as if you were physically measuring these data so, obviously, you have more accurate results if you make measurements at several points (in any case Ramsete performs the calculations, but will not tell you because you have requested to not measure them). At this point the geometric model is complete:
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Figure 9: Final geometric model.


Ramsete save a .RAY file (a simple text file), and now you can launch the computation with the Ramsete Tracer module. We load the .RAY file which we want to compute and customize the parameters:
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Figure 10: Ramsete Tracer.
1) Subdivision level: This parameter indicates how many pyramids will be drawn, that is how many times the source is splitted into two parts starting from 8. Initially the source is already divided into 8 wedges (eight octants) if you enter a value equal to 1, then 8 pyramids will shoot, if you enter 2 as the value then 16 pyramids will shoot etc... So 
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 pyramids will be launched.
2) Time: it represents the length of the impulse response that the program will calculate. For example, if an environment has 0.7 s of reverberation time, then 2s are more than enough.
3) Time resolution: it defines the slice in time which is used for computing the impulse response, so a ten millisecond slot is enough in most case.
4) Humidity and Temperature.
5) Diffraction level: If "Two" is selected, it computes the second-order diffraction (particularly useful in environments where there are barriers).
6) History: If "Off" is selected, Ramsete follows all the paths of all pyramids. Otherwise you can insert the number of bounces you want to follow, after which the pyramid tracing is abandoned.
7) Randomize after: Represents the maximum number of specular bounces before the rays are diffused.
8) Save hits: Save the history of the first N bounces, allowing to see the path that the rays have followed.
9) Diffusion: If it is enabled, Ramsete takes into account the surface scattering coefficient s of materials.
10) Save diffuse hits: it allows to save the trajectories of diffused rays.
11) Save separate sources: it allows to create a different result file for each source present in the geometry. Ramsete will create a file .__A and .__B etc.. for each source in the geometry.
12) Save escaped rays: it saves the trajectories of rays escaped from the geometry.
By clicking the start button the computation starts and a new window will show you how long it will take.
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Figure 11: During computation
At this point the computation is done and we can look at the result employing the third main program: Ramsete View. 
By opening this file, Ramsete calculates for each receiver the direct wave travel time (Taudir) that is the "time of flight" of the direct sound, the equivalent level Leq and one of the spatiality parameters (LE).
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Figure 12: Loading a .___ file with Ramsete View.

At this point, the geometry is loaded and we can see both in 2D or in 3D (View -> Draw 3D).
We can look at the result in various way, the most important is to look at the impulse Response (View -> Impulse Response):
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Figure 13: The impulse response of the receiver 35 at 1 kHz.

This window shows the impulse response of each receiver, and shows in the top right corner the decay time of the reverberant curve (RevTime).

We can also look at the table of the Reverberation time, for example the Table of T20:
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Figure 14: Table of T20.
The first row of the table is already the average of the room. So here we can see if the value at every frequency are close to the experimental value or not. 
If they're not close we need to changes the material proprieties. For example in Fig.14 we can see a wrong value at 125 Hz (the experimental value was approximately 1.0s).
We can also get the value of other acoustical proprieties such as the clarity C50 which is the clarity for speech, or the Speech Transmission Index (STI).
Finally we can chart the results, for example we can chart the sound pressure level in the room.
Using the tool Map-> DoDither 2D and select Leq from "Parameter":
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Figure 15: Mapping options.

And this is the result, obviously the loudest point are those immediately close to the loudspeaker
The loudspeakers are always considered working at maximum power, that is not a realistic level.
So if you want to make a more realistic simulation you should reduce the power of the loudspeakers (maximum power, instead, makes sense for a noise source):
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Figure 16: Mapping Leq.

In some cases you can see in the inpulse response a strong peak very late in time which is disturbing. 
That’s called an echo.

When it happens, you can see from where the reflection comes. First of all you need to go in 3D mode, so you can see the ray path with the tool View->Ray Path (it is possible only if the "Save this" flag was enabled during the computation in Ramsete Tracer). You still see a chart like the input response before, but now the pink lines represent the discrete ray paths. You can move the cursor looking at the path of each ray. When you find a disturbing echo, you can see the path of the ray and reduce its amplitude by adding a
sound-absorbing material to one of the surfaces hit by the ray during its path.
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Figure 17: View the Ray Path.

Ramsete can also operate with very complex geometry drawn with AutoCAD, by importing them in Ramsete CAD with File-> DXF in.
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Figure 18: Import a .dxf file from AutoCAD.

Finally you can navigate the drawing with an OpenGL rendering tool in Window->3D. This is very important to check if there are no holes in the drawing otherwise the ray can escape from the geometry and the computation becomes wrong.
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Figure 19: 3D Navigation inside the drawing.
With a simple auralization Tool (AURORA), Ramsete View has the possibility to export the result as a .wav file (File-> Export Imp.Resp. to WAV..). 
So you get a simulated inpule response, that you can compare, by listening it, with the measured inpulse response.
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Figure 20: Export a .WAV file.

You can compare it directly with the measured impulse response of the room, for example by packing both in a single stereo file (one in the right channel and the other in the left).
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Figure 21: Comparing two impulse responses.

We should now refine the simulation until we get more or less the same reverberation time at every frequency and also the same sound pressure level. When the numerical simulation is perfectly tuned you usually get errors of sound pressure level of less than one decibel and less then 0.1 second for the reverberation time at every frequency. If the simulation is properly done the two signals sound very similar.
Conclusions
Ramsete allows you to perform in a very simple way, a simulation of sound propagation indoors in a very short time.

This software is not designed to be used from a software engineer but it is for normal people who know little about acoustic, so you don't need to understand the pyramid tracing algorithm or the detail of the ray correction but you only have to know that there are sources with their directivity and power, there are receivers and a geometry with the material proprieties.
By changing those input data to the software properly, the user can drive the software to produce results as close as possible to the measurement results.
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